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 .קרדיט ליוצריםמסחריות בלבד תוך מתן -מותר להשתמש בחומרי הקורס כמו שהם )ללא שינוי( למטרות לא

 סליחה על השאלהתרגיל: 

 
 ?הזה תרגילב נלמדמה 

 יכול לעזור לנו לכתוב נוסחאות. GPTבתרגילים הקודמים ראינו איך 

 .בנושא אקסלכאן נראה איך הוא יכול לעזור לנו בעוד כל מיני דברים 

 להרבה מטרות נוספות. GPT-רק דוגמאות, אפשר להשתמש בהשימושים שנציע כאן הם שכמובן 

 

 
 הצילו, נחש!

: אנחנו עדיין בעניין כתיבת נוסחאות, ורוצים לדעת איך להשתמש בפונקציה מסוימת. במקום לקרוא פשוטהכי 

 . לדוגמה, נסו לשאול אותוGPTבאתר של מיקרוסופט, אפשר לשאול את 

What is the SUM excel function? 

בכמה דוגמאות אז קחו בחשבון שייתכנו טעויות. אבל , ובדק ולא משהו שבן אדם כתב AIלזכור שזה  – כרגיל

לשיקולך  –שאני ניסיתי, הוא ענה די יפה. הוא גם נתן הסברים קצרים יותר מההסברים באתר של מיקרוסופט 

 אם זה נחשב בעיניך יתרון או חיסרון.

 

 ציה להשתמש?באיזו פונק

איך ״לפרק״ את הבעיה למרכיבים שלה. ראינו את זה אחד האתגרים בכתיבת נוסחאות אקסל מורכבות הוא 

 גם בפרק הזה של הקורס וגם בפרק הקודם. ,בכמה דוגמאות בתרגילים קודמים

י הוא . גורם אחד הוא אם הבעיה עצמה מסובכת. גורם שנקשהלהיות הזה  ״פירוקיש כמה דברים שגורמים ל״

לדעת שבשביל לפרק את הבעיה כולה )נוסחה מורכבת( לאבני הבניין שלה )פונקציות בודדות(, אנחנו צריכים 

במיוחד אם אנחנו קצת פחות מיומנים, ולא זוכרים היטב  –לפעמים זה קשה באילו אבני בניין כדאי להשתמש. 

 את כל הפונקציות של אקסל.

 עזרה בדיוק בזה.  GPT-אפשר לבקש מ

 

 למצוא באגים בנוסחה

GPT  בגדול, זה לא השימוש האידיאלי ב בנוסחאות שלנו.)באגים( יכול לעזור לנו למצוא ולתקן כל מיני תקלות-

GPT ,כמו שכבר אמרנו בשיעור ״מה זה הקשקוש הזה״ .GPT  ,מאד טוב בלתת לנו מידע שכבר קיים באינטרנט

וסחה, סיכוי סביר שהבעיה הספציפית הזאת תהיה כזאת באג בנהוא פחות טוב בליצור מידע חדש. במקרה של 

 בואו נראה כמה דוגמאות.לא נתקל בה. ועדיין, לפעמים הוא יצליח לעזור, לפחות באופן חלקי.  GPT-ש

 הודעת שגיאהפענוח 

זה מקרה קלאסי  .אותהאקסל עצמו נתן לנו הודעת שגיאה, ואנחנו לא מבינים נתחיל עם דוגמה פשוטה יחסית: 

צריך פשוט לדעת מה המשמעות  –צריך הרבה יצירתיות כדי לפתור אותה לא בעיה שזו יוכל לעזור, כי  GPTבו 

 של הודעת השגיאה.

יש פה נתונים של כמות ילדים וכיתות בביה״ס ״אורט . classesבגיליון  GPT-examples.xlsxפתחו את הקובץ 

 כתבנו Dכמה כיתות צפויות להיות. בעמודה  Cדה כמה ילדים יש בכל שכבה, ובעמוכתוב  Bבעמודה אתונה״. 

 )הסתכלו על הנוסחה(.  את גודל הכיתה הממוצע

ייתכן שכבר פגשת את השגיאה הזאת, או שניחשת בקלות שגיאה בנוסחה. יש של כיתות ד׳ שימו לב שבשורה 

 :GPTאפשר לשאול את  –מהי. אבל אם לא 

In Excel, I have data in columns B and C, and in column D I have B/c, for example, The 

formula in D2 is =B2/C2. In some rows I get a #DIV/0! error. Why? 

 , וגם שתי הצעות לתיקון:)כרגיל קצת קיצרנו כאן( קיבלנו הסבר יפה ומפורט
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The #DIV/0! Error in Excel occurs when you try to divide a number by zero. In your case […] if the value 

in column C is zero, Excel cannot perform the division operation, and it returns the #DIV/0! Error. 

To avoid this error, you can modify your formula to include an IF statement to check if the 

denominator (the value in column C) is zero before attempting the division. Here’s an example: 

=IF(C2<>0, B2/C2, “Division by zero error”) 

This formula checks if the value in B2 is not equal to zero. If it is not zero, it performs the division; 

otherwise, it returns the text “Division by zero error” or any other message you prefer. 

Alternatively, you can use the IFERROR function to handle errors more generally: 

=IFERROR(B2/C2, “Division by zero error”) 

 

 :GPT. שאלנו את לבעיה מה הסיבהאולי כבר הבנת , אבל Cבעמודה  0שלנו לא רשום שימו לב שבקובץ 

I don't have any zero values in C. But I do have some empty cells, could that be the 

problem? 

 –במקרה זה הפתרון מיותר שימו לב ש .הסביר בפירוט את הפתרון שלואפילו הוא ענה יפה וגם הציע פתרון ו

 גם שני הפתרונות הקודמים, הפשוטים יותר, היו עובדים:

Yes, if you have empty cells in column C, it can indeed lead to the #DIV/0! error. 

To handle both zero and empty cells in column C, you can modify the formula using the IF function 

to check for both conditions. Here's an example: 

=IF(OR(ISBLANK(C2), C2=0), "Cannot divide by zero or empty cell", B2/C2) 

This formula uses the OR function to check if either the cell in column C is empty (using ISBLANK(C2)) 

or if it is equal to zero (C2=0). If either condition is true, it returns the specified error message; 

otherwise, it performs the division. 

 מצליח ממש יפה GPTלפעמים 

אם מדובר בבעיות פשוטות יחסית, ייתכן שהוא יצליח לפתור לנו את הבאג. לדוגמה, נניח שרצינו לספור כמה 

. אנחנו לא זוכרים בדיוק את השימוש בנוסחאות 10-וקטנים מ 4-הם גדולים מ A1:A100מהערכים בטווח 

בשביל  ANDבשביל לספור, ובפונקציה  COUNTIF-טיות, אבל כן זוכרים שזה כנראה דורש שימוש בהרלוונ

 כתבנו את הנוסחה הבאה:אז  שני תנאים.לבדוק שילוב של 

=COUNTIF(A1:A100, AND(">4", "<10")) 

 , נסו לבד:GPTלפני שנלך לדבר עם 

 מדוע הנוסחה הזאת שגויה? )התשובה בסוף התרגיל( .1

 לתקן אותה? איך אפשר .2

שאנחנו  prompt-שמציג לו את הבעיה. בסוף הקובץ תראו את ה prompt. כתבו GPTאל  –ועכשיו  .3

 כתבנו.

 :. הוא התחיל ככהGPTהנה התשובה של 

The formula you provided is attempting to use the COUNTIF function with a logical AND condition. 

However, the COUNTIF function does not directly support logical operators like AND or OR within its 

criteria. 

 . אם כי לא מלאה התשובה טובה

GPT  נכוןוהפתרון  –מציע גם פתרון: 

To achieve your desired result, you can use multiple COUNTIF functions and then add them together. 

Here's how you can modify your formula: 
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=COUNTIF(A1:A100, ">4") - COUNTIF(A1:A100, ">=10") 

This formula counts the number of cells in the range A1:A100 that are greater than 4 and then 

subtracts the count of cells that are greater than or equal to 10. This effectively gives you the count of 

numbers in the range between 4 (exclusive) and 10 (inclusive). Adjust the criteria as needed for your 

specific case. 

 חצי מצליח GPTלפעמים 

 איזושהי מילה בעברית.  A1כתבו בתא הפעם ממש באג.  –נמשיך לדוגמה נוספת 

, נוסחה שמחזירה את האות הראשונה )הכי ימנית( במילה הזאת. אז כתבנו B2וב, בתא המטרה שלנו היא לכת

 את הנוסחה הבאה:

=RIGHT(A1, 1) 

 : מדוע הנוסחה הזאת שגויה?)בלי לבדוק באקסל(נסו לחשוב לפני שתכתבו את הנוסחה ותבדקו אותה,  .4

 .(התרגילתשובה בסוף ה)נסו את הנוסחה רק אחרי זה, 

שמבקש ממנו עצה )בסוף הקובץ תמצאו  GPT-ל promptכתבו נניח שאנחנו לא יודעים מה הבעיה כאן.  .5

 שאנחנו כתבנו(. prompt-את ה

 ענה לנו: GPT-זה מה ש

The RIGHT function in Excel is designed to extract characters from the right side of a text string. Since 

Hebrew is written from right to left, using RIGHT will indeed give you the last letter of the word. 

To extract the first letter of a Hebrew word in cell A1, you can use the LEFT function instead. Here's the 

correct formula: 

=LEFT(A1, 1) 

 

ניסיתי לשאול אותו עוד כמה שאלות אבל כמו שתוכלו לראות, הפתרון שהוא הציע נכון, אבל ההסבר לא מדויק. 

 לא הצלחתי לגרום לו להסביר את ההסבר הנכון.

 ,ספציפית לגבי עבריתמאד שאלה  GPTשאלנו את . התקשה כאן GPT-ש שימו לב שאולי זה לא צריך להפתיע

 חומר על בעיות מהסוג הזה. ייתכן שאין באינטרנט הרבה ו

 לגמרי נכשל GPTלפעמים 

 .personal-infoבגיליון  schools.xlsxפתחו את הקובץ 

האם הילד נולד בארה״ב או לא. , I, בעמודה לכתובהלידה של כל ילד. אנחנו רוצים ארץ  מהרשו Eבעמודה 

 ״ אלא ממש רשומה המדינה.USA״בתור  מה סתםרשולא הלידה שארץ שימו לב 

כתבו אותה )ולא את התשובה  –מופיעה התשובה שלנו  בסוף הקובץ .לכתוב נוסחה כזאת איךנסו לחשוב  .6

 ., והעתיקו לכל השורותIבעמודה  (שלכם.ן

 זה לא עובד, נכון?

 בסוף הקובץ תוכלו לראות מה שאלנו אותו, ומה התשובה שקיבלנו. ?GPTמה תשאלו את  .7

אבל בכל הניסיונות שלנו, הוא לא הצליח למצוא את  –ניסינו כמה וריאציות על השאלה, וגם לעזור לו קצת 

 הבאג.

 ☺נסו למצוא את הבאג בעצמכן.ם!  .8
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 למה רק פונקציות?

 בואו נראה שתי דוגמאות.גם לגבי דברים שבכלל לא קשורים לפונקציות.  GPTאפשר להתייעץ עם 

 ד״ר ג׳קיל ומיסטר הייד

 דוגמה הזאת נוגעת לעיצוב מותנה של תאים:ה
In an Excel file, A1:A20 include gender, B1:B20 are height. I want to format height in red 

only for males. How? 

GPT  טובהנותן תשובה: 

To format the heights in red for males in Excel, you can use conditional formatting. Here’s how you 

can set it up: 

1. Select the range of heights in column B (B1:B20). 

2. Go to the “Home” tab in the Excel ribbon. 

3. In the “Styles” group, click on “Conditional Formatting.” 

4. Choose “New Rule” from the dropdown menu. 

5. In the “New Formatting Rule” dialog box, select “Use a formula to determine which cells to 

format.” 

6. In the “Format values where this formula is true” field, enter the following formula: 

=A1=”Male” 

 

 זבנג וגמרנו

. נבחר שאלה דומה בואו נאתגר אותו קצת יותר, ונבקש ממנו לתת לנו לא פתרון אחד אלא כמה פתרונות

 :בתרגיל הקודם GPTלזאת שהצליחה לסבך את 
In an Excel file, A1:A20 include gender, B1:B20 are height. How do I compute the average 

heights of all women higher than 165, without writing formulas? Please give 4 alternative 

methods to do this. 

הן נה התשובה שלו. שתי האופציות הראשונות הן דברים שלמדנו בקורס הזה. שתי האופציות הבאות ה

  .דברים שלא למדנו

זה לא המצב כרגע, אבל אפשר . שורת כותרתמניח שהשורה הראשונה בקובץ היא  GPT-ששימו לב גם 

 לתקן את זה בקלות.

1. Using Filters: 

- Select the range A1:B20. 

- Go to the “Data” tab in the Excel ribbon. 

- Click on the “Filter” button to enable filters in the headers. 

- Use the filter in column A to select only “Female.” 

- Use the filter in column B to set a custom filter to show heights greater than 165 cm. 

- Observe the filtered list of women taller than 165 cm. 

- Manually calculate the average of the visible heights. 

 

 אפשר לנסות! ההסבר נכון והשיטה עובדת.

 :הציע GPT-נמשיך לאפשרות השניה ש

2. Pivot Table: 

- Select the range A1:B20. 

- Go to the “Insert” tab in the Excel ribbon. 

- Click on “PivotTable.” 

- In the PivotTable Field List, drag “Gender” to the “Rows” area and “Height” to the “Values” 

area. 
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- In the “Values” area, it will default to “Sum of Height.” Click on the drop-down and select 

“Value Field Settings.” 

- Change the calculation to “Average.” 

- Filter the table to show only “Female” in the “Gender” field and heights greater than 165 cm. 

- The average height of women taller than 165 cm will be displayed. 

 

 אפשר לנסות!ההסבר נכון והשיטה עובדת. 

 :עם זאת, שימו לב שהוא קצת התרשל

 165-לפי גובה גדול מלא הסביר לנו איך לסנן הוא  -

כך שנראה רק את הנתונים לסנן להציג גברים ונשים לחוד )בשתי שורות נפרדות(, וגם הוא מציע  -

 . אין צורך לעשות את שני הדברים, אחד מהם מיותר.נשים

 

 

3. Subtotal Function: 

- Sort the data based on height in descending order. 

- Select the range A1:B20. 

- Go to the “Data” tab in the Excel ribbon. 

- Click on “Subtotal.” 

- In the “At each change in” dropdown, select “Gender.” 

- In the “Use function” dropdown, choose “Average.” 

- Check the “Replace current subtotals” box. 

- Click OK. 

- Excel will insert subtotals for each gender. Collapse the “Male” group, leaving only the 

“Female” group visible. The average height of women taller than 165 cm will be displayed. 

 

את המטרה שלנו.  אכן קיימת, אבל היא לא תשיג – subtotal –הפעולה שהוא מתאר . קצת התבלבל GPTכאן 

 .וללמוד אותה subtotalפעולת לשחק קצת עם אבל אם תרצו, בהחלט אפשר לנצל את ההזדמנות כדי 

 

4. Excel Tables: 

- Convert your data range into an Excel Table. Select the range A1:B20, and press Ctrl + T (or 

Insert > Table). 

- A “Create Table” dialog will appear. Make sure the “My table has headers” option is checked. 

- Once you have a table, you can filter it by clicking the filter icon in the “Gender” column and 

select “Female.” Then, filter the “Height” column to show values greater than 165. 

- Manually calculate the average of the visible heights in the “Height” column. 

 

, כך שאין יתרון בשיטה (רגילסינון )עבודה עם  1אם כי היא מאד דומה לאופציה מס׳  – האפשרות הזאת נכונה

 .בשביל המטרה שלנו הזאת

 

 לייצר נתונים פיקטיביים

 לפעמים זה שימושי. – כדי ליצור לנו נתונים פיקטיביים GPT-אפשר להשתמש ב

  .(2לא נחזור על זה כאן, כיוון שכבר תיארנו את זה בפירוט בתרגיל ״זבנג וגמרנו״ )שאלה 
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 שאלות כלליות

לדוגמה,  , ולא רק שאלות בסגנון ״איך לעשות את זה״.שאלות כלליות GPTבהחלט אפשר לשאול את 

״זבנג וגמרנו״ דוגמה לשימוש ראינו בתרגיל שזוכר.ת  – CSVעת לקבצי שאלה שנוג ניסינו לשאול

 :שאלנו כך ? אזבקובץ כזה

What is the benefit of exporting an excel file to CSV format? 

  האם היא באמת עוזרת לך?. הפעם נשים פה את התשובה המלאה –הנה התשובה שקיבלנו 

Exporting an Excel file to CSV (Comma-Separated Values) format offers several benefits: 

1. Simplicity and Universality: CSV is a plain-text format with a simple structure. It consists of rows 

and columns separated by commas (or other delimiters). This simplicity makes it easy to 

understand and widely compatible with various applications, including spreadsheet software, 

databases, and programming languages. 

2. Data Interoperability: CSV is a universal data exchange format that can be used across different 

platforms, operating systems, and software applications. It allows you to share data with users 

who may not have Excel or use a different spreadsheet program. 

3. Reduced File Size: CSV files tend to be smaller in size compared to Excel files. This can be 

advantageous when you need to transfer or store data with limited storage or bandwidth. 

4. Data Integrity: When you export to CSV, you can avoid issues related to Excel-specific features, 

such as formulas, macros, and formatting. This helps maintain data integrity and prevents 

unintentional modifications when sharing data. 

5. Data Standardization: CSV enforces a simple, consistent structure, making it easier to standardize 

data for data analysis, data migration, and integration with other systems. 

6. Easier Text-Based Manipulation: CSV files can be easily edited and manipulated using text editors 

or code. This is especially helpful when you need to perform batch operations, search and replace, 

or automate data processing. 

7. Database Import: Many database systems and data analysis tools allow you to import data 

directly from CSV files. This simplifies the process of populating databases or conducting data 

analysis. 

8. Version Control: Storing data in a plain-text format like CSV can simplify version control and 

collaboration in software development projects, where changes to data files need to be tracked. 

9. Compliance and Regulations: In some cases, organizations may be required to share data in CSV 

format to comply with industry standards, regulations, or reporting requirements. 

10. Avoiding Excel-Specific Issues: Exporting to CSV can help avoid compatibility issues that may arise 

when sharing Excel files, especially if recipients are using different versions of Excel or other 

spreadsheet software. 

11. Automation: Exporting to CSV can be easily automated through Excel VBA (Visual Basic for 

Applications) or other scripting languages, allowing for the streamlined extraction and conversion 

of data. 

In summary, exporting an Excel file to CSV format provides a practical and versatile way to share, 

standardize, and work with data across various platforms and applications. It simplifies data 

exchange, ensures compatibility, and reduces the risk of formatting or formula-related issues. 

 

וחלק מהסעיפים לא בהכרח מתמקדים , דיוקים קטנים-כמה איבה יש אם כי  ,לא רעהמבחינה עובדתית, התשובה 

לא זה, אלא הבעיה המרכזית היא אני מרשה לעצמי לנחש שמבחינתך אבל  .CSVקבצי ים של המרכזיביתרונות 

אם אז , במחשבים וקבצים ותכנות מניח פה שיש לנו ידע מוקדם די רחב GPTשהתשובה לא מספיק ברורה. זה 

הרי  – להתרגשאבל לא  .רק חלק קטן מהסעיפים בתשובהצלחת להבין השסביר סיכוי יש , .תמתכנתאת.ה לא 

 :, זה לא זבנג וגמרנוומשא ומתן שיחהזה תמיד  GPTאנחנו זוכרים שעם 

I don’t know anything about programming, and I am not a computer expert. Can you give a 

simpler answer? 
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Of course! Exporting an Excel file to CSV format is beneficial for people who are not computer experts 

because: 

1. Simplicity: CSV files are much simpler than Excel files. They only contain basic text and numbers 

separated by commas. You don’t need to worry about complex Excel features like formulas or 

formatting. 

2. Compatibility: CSV files work with many different computer programs, not just Excel. So, if you 

want to share your data with others, they can open it with their preferred software. 

3. Smaller File Size: CSV files are often smaller, which is helpful when you want to save space on 

your computer or share data online. 

4. Avoiding Problems: Converting to CSV helps avoid issues that can happen when sharing Excel 

files, especially if others use different versions of Excel or different software. 

In summary, exporting to CSV makes your data easy to share, simple to work with, and compatible 

with many programs, even if you’re not a computer expert. 

 עכשיו זה כבר קצת יותר ברור.
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 תשובות לשאלות בקובץ זה

אמורים להיות ערכים  ANDשגוי. הארגומנטים של  AND-השימוש ביש פה שילוב של שתי בעיות. ראשית,  .1

יודעת לקבל תנאים  COUNTIFאמנם הפונקציה  לוגיים )תנאים(, כאן הם שני ערכים מסוג מחרוזת.

 ANDוההתנהגות של  –לא יודעת לקבל ארגומנטים כאלה  ANDמסוימים שכתובים בתור מחרוזת, אבל 

 .COUNTIFבתוך לא תשתנה רק בגלל שכתבנו אותה 

הארגומנט מחזירה ערך לוגי, אבל  ANDהפונקציה שגוי.  COUNTIF-מוש בהבעיה השניה היא שגם השי

 . הוא לא ערך לוגי COUNTIFהשני של 

 , שבודקת שילוב של כמה תנאים:COUNTIFSהיא להשתמש בפונקציה יש כמה דרכים לתקן. אחת מהן  .2

=COUNTIFS(A1:A100,"<10",A1:A100, ">4") 

 הציע לנו. GPT-עוד מעט נראה פתרון נוסף, ש

 זה מה שאנחנו שאלנו: .3

Why does this Excel formula always return 0? 

 =COUNTIF(A1:A100, AND(">4", "<10")) 

. הטקסט בעברית אמנם מוצג על המסך מימין לשמאל, אבל דיברנו על זה קצת בתרגיל ״זמורה ביתן״ .4

מחזירה את האותיות האחרונות  RIGHTה יש לו התחלה וסוף. הפונקצי –אין לו כיוון בזיכרון של המחשב 

 .LEFT(A1, 1)אז הנוסחה הנכונה היא את האותיות הראשונות.  LEFTבטקסט, והפונקציה 

 זה מה שאנחנו שאלנו: .5

In Excel, I wanted to extract the first letter from a Hebrew word in the cell A1. Hebrew is 

written from right to left, so I wrote the following formula: =RIGHT(A1, 1) This doesn't 

work - it gives me the last letter of the word instead of the first. 

כדי לחפש  FINDיש כמה דרכים אפשריות. במקרה זה, הפתרון שבחרנו בו היה כזה: נשתמש בפונקציה  .6

שהפונקציה הזאת מחזירה שגיאה במקרה שהיא לא . אנחנו יודעים USAבארץ הלידה את רצף התווים 

החזירה שגיאה או  FINDכדי לבדוק אם  ISERRORמצאה את רצף התווים הנכון; אז נשתמש בפונקציה 

בארץ הלידה, כלומר הילד  USAלא. אם היא החזירה שגיאה, זה אומר שהיא לא מצאה את רצף התווים 

 א הצליחה, סימן שהילד כן נולד בארה״ב.לא נולד בארה״ב. אם היא לא החזירה שגיאה אל

 כתבו אותה בקובץ, והעתיקו לכל השורות: –היא זאת  2הנוסחה לשורה 

=IF(ISERROR(FIND(E2, “USA”)), “non-US”, “US”) 

 שאלנו אותו כך: .7

In cell E2, I have the country name, and I want to check if it's in the USA or not. I use 

the following function: =IF(ISERROR(FIND(E2,"USA")), "non US", "US") It doesn't work - it 

says "non US" even if E2 contains the characters "USA". Why? 

 התשובה שלו:

The issue you're encountering might be related to case sensitivity. The FIND function in Excel is case-

sensitive, so if the text in cell E2 is "usa" or "UsA," the function won't find "USA." If you want a case-

insensitive check, you can use the SEARCH function instead of FIND. Here's an updated version of your 

formula. 

ן רגישה להבדל בין אותיות גדולות/קטנות באנגלית. אבל זאת לא אכ FINDהפונקציה  –המידע הזה נכון 

 .לבאג בנוסחה שלנוהסיבה 

בנוסחה נובע מכך שלהבדל בין אותיות גדולות/קטנות. הוא הבאג בפונקציה שלנו לא קשור ראינו קודם ש .8

, הארגומנט הראשון הוא הטקסט שאותו מחפשים, FINDבפונקציה סדר הארגומנטים היה הפוך. שכתבנו, 

הטקסט שבתוכו אנחנו מחפשים את הארגומנט הראשון. כלומר, היינו צריכים לכתוב והארגומנט השני הוא 

 כך:
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=IF(ISERROR(FIND(“USA”, E2)), “non-US”, “US”) 
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